The NatureMapping Program  NatureTracker has been designed as a simple yet high-tech field
NatureMapping Foundation  notebook to provide users another tool for developing naturalist,
Federal Way, WA 98093  tracking, and basic GIS skills.
http://naturemappingfoundation.org/natmap/naturet
racker NatureTracker guides you to look just a little more intensely to the
rhythms of the world.

This Quick Guide is the first of three user manuals.
e The Complete NatureTracker supplements the Quick
Guide.
e The Advanced NatureTracker is used in NatureTracker
workshops that train users to develop their own queries and
reports.


http://naturemappingfoundation.org/natmap/naturetracker
http://naturemappingfoundation.org/natmap/naturetracker
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IMPORTANT NOTE: A sample set of data (43 records) and

begin practicing after you have loaded the software on the PDA
and PC. If you do not want to practice — delete the data before
adding any of yours. Instructions are at the end of this manual.
If you do want to practice (highly recommended) download the

e ¥
ﬁ* an associated map is in NatureTracker to practice. You can

Ohop Practice Sheet

(http://naturemappingfoundation.org/natmap/naturetracker)

Load Cybertracker and NatureTracker on PC

1.

Loa

Make sure you have “Administrator” rights to load CyberTracker (CT) onto your
computer if you are on a network. Problems that can occur if you don’t have
Administrator rights are:
1. Youcan’tload CT
2. You load CT but you can’t load NatureTracker
3. You load CT and NatureTracker, but the data won’t download
Load the PDA’s software onto your PC.
Do not connect the cable and PDA to your PC until told to do so.
Accept the defaults to Finish.
Download the latest version of CyberTracker from their site:
http://www.cybertracker.org/software/free-download
Put the NatureTracker CD into the PC and look at the files on the CD.
Read the Readme File
Open CyberTracker on your PC
Open Database

. Select “NatureTracker2011.CTX” from the CD

. Once the database is open, select “Save Database As” from the “File” menu.

. Name the database NatureTracker

. Save the NatureTracker database in the “My CyberTracker Databases” folder in
your “My Documents” folder (the default folder).

d Cybertracker and NatureTracker on PDA
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15
16
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. Keep the PDA hooked up

. Click on the Applications from the Menu

. Select either the Palm or Windows Mobile icon depending on your unit

. It will download the NatureTracker sequence onto the handheld/PDA

. IMPORTANT NOTE: You need to register with CyberTracker
International via the internet and receive a registration key before you will be


http://naturemappingfoundation.org/natmap/naturetracker
http://www.cybertracker.org/software/free-download

allowed to synchronize with your PDA. The registration key will arrive by email,
typically within two minutes (but we recommend allowing for more time in the
event of a delayed response).

Register CyberTracker R

Weleome to CyberTracker.
This message only appears if vou have not registered.

Registration is simple, just send details of vour project to us at
“register@cybertracker.co.za" and a key will amtomatically be sent to you.

In order to provide you with free software of the highest quality, we
depend on donor funding for ongoing research and development.

To justify additional funding it is important for us to get feedback from you.
Without vour input we will not be able to provide you with improved
software as new technology develops in the futre.

Your email address will remain confidential and will not be distributed

Gat key egister@ o tetackar o 2a

Entor kay [ mugir |

Seral Down Cancel

19. Hit “yes” on the handheld when asked to continue with the 2™ hotsync

20. Hit “ok” on the PC and synchronize once again.

21. You will see “Building sequence”....be patient, it may take a few minutes.

22. When completed, the NatureTracker sequence screens should be active on the
PDA.

Copying the Map example from the CD
23. There should be a folder titled “Maps” in the “My CyberTracker Databases”
folder in your Document folder.
24. Copy ohop_a.tif file from the CD to the Maps folder.
25. Watch the two slide shows on the NatureTracker CD to learn how to use the PDA
and about animal sign icons and their meaning.

IMPORTANT NOTE:

e Give yourself adequate time (30 — 60 minutes) to add PDAs, load NatureTracker
sequence on each PDA, and allow the GPS units to acquire their first location
before you begin collecting data.

e Make certain that the batteries on all PDAs are fully-charged before you begin
collecting data.

e NatureTracker will not be removed from the PDA if the batteries go dead, but the
date and time must be updated before NatureTracker will work.

e CyberTracker icon will be put on your desktop.

=
CyberTracker

(Professional)
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Download Data from the PDA

Delete sample data before continuing — See instructions at the end of this manual

1. Connect the PDA to the connection cable. Synchronization will begin
automatically.

2. Downloaded data will be added to the database and will be viewable immediately
on your tables. Data are erased from the PDA when they are downloaded.

3. You should see your data in a table.

E Query Editor

/ Dataviewel} Dlharspecies} F‘hntorecnrds} Location} ‘Weather © Follawing ~ Tracker

= Propeties [*] W [bserverID =5135) e
Mame o
Date range Tracker » Observe % Species % Huestior % | Date | Latitude »  Longitud % | Photo ac % | Quantity % Habitat & | Addition:
Diate fram 1041242008 b Tracker B 4923 Steller's jay |1 am certain |10/12/2008 1 324 3
Date to 1041242008 Tracker B 4923 American cr| | am certain | 10/12/2008 | 468691283 122 2344101 1 324 1
= (st Tracker B 4923 Winter wren | I'm uncertair| 10/12/2008 | 46.8693683: 122 344381 2 324
1 of 125 Tracker B 4323 Dark-eyed [[|I'm uncertair | 10/12/2008 | 46.869545 | -122 345257 1 324 Explainic” |
77} 7] » ™ Tracker B 4323 ‘winter wren |I'm uncertair | 10/12/2008 | 45.87054161 122, 345838 1 324
D ouble-click below to create column Tracker B 4323 Virgiria rail | 1'm uncertair| 10/12/2008 | 46.86333661 -122.35744 1 324 | &
11 ’ 1]
4. Change the date to “Today’s date” to show only your current data. Select the

arrow when you highlight Date range to see the options.

/ Data viewer | Other species | Photo records |
= Properties

Mame Data viewer
Date range {Custam Wi
Date from 101242008
Date to 10/12/2003
= Inspector
1of 125

5. Look at the latitude/longitude columns to make sure they do not have 1000.00.
This means the GPS didn’t take a reading. You can edit and add lat/long data by
either copying the lat/long from the record above or below it. (Points will not
display if there is not a lat/long)

6. Edit obvious errors.

e The active sighting can be selected by clicking
o the arrows at the top of the inspector to find the correct record
e adifferent row on the active table

7. Select the NatureMapping export under reports.

[ atirn rackar - Cyberi rackar Pratessianal v2.103 = I=]
Fle Edt Yew ook Help

2Bt - - oo > or. - = Ovoy Edios =

New Query Delete Sghtngls) ~ AddPhoto  New Vew WiewProperties  Export View  Manage feports  Swne

ﬁ_'..llnux Ediror
Mahaehlopong Expor
=i Fugmiins

Hame HenaeMapprg Expot LN | -
Dinte hrge a1 ObeICo Speciesid o O o Dote o~ St Co w Lt » Log  w Sowce w Dty Cotimate » Habkel w Commen ¢ Species ¢ CodedSpe % Mew Species »
Dite borm g G005 |Black-cepped chicl TAROT Wik (03D 4770056 12 M6A0T 2 1 ]
ot be 20 G005 Sponedtowhes THROT |Wh (033 (ATTAETIE AN AT 2 1 =]

AEN05T | D meuse BT (WA (00347 FEENE AN SEn g T an
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8. Export your data to a spreadsheet for your own use for graphs or GIS
9. Export as a spreadsheet and upload to the NatureMapping Program via the
website.

Photos

You can add a digital photo to a sighting and then see it with the photo view. You may
add more than one photo to a sighting. For example, you may want to add a detailed
photograph of a plant or animal, plus a second photograph of the surrounding landscape.

Adding a Photo
1. Locate and activate the sighting to which you want to add the photo(s).

2. Click the “Add Photo” icon.

3. In the browse window, navigate to the location where you have stored the photo
you want to add.

4. Select the photo file.
e Add more than one photo at a time by holding the Control key while clicking
each file you want to add.

5. Click “Open”,
6. Repeat steps 3 — 6 to add additional photos to the sighting.
IMPORTANT NOTE: Graphics files are often large (> 1 MB). Adding photos can

increase the size of your database, which may lead to slower PC performance and longer
time to open, save, and export the database.
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IMPORTANT NOTE:
You can insert a map as described below, or if linked to the Internet, use Virtual Earth:
1. Openamap
2. View Properties
3. Select Advanced
4. Select Virtual Earth

Inserting a New Map -
1. Copy your map into the “Maps” folder in the “My CyberTracker Databases”
folder in your Document folder.
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2. Start CyberTracker and open the NatureTracker database.

3. Click the “New View” icon.

[ atarsTrachar -

B E& :;w Hocks I!'\r

Reports = Data views: = i ™ - Query Cditor =

1 o % U - i
New Query  Delete Query  Dekete Sohingls) | Add View Properties  Evport View  ManageReperts S
1 3y £

- (o]

Disth vidwss | Dfist spbcinn | Phodn imcoide | Locafion . Wiesther | Folowing| Tisckat| Tratket1| Tiscke?! Tracket| Tisckstd | Tescket5' TrackarG| Tisckat7 | TesckerD  Tracksrd| Tiscked 100 Tracker 10| Teschd ' P

Fropetns
[ Dl vatwees
[ T— 4 Trackes % [lbaerve % Species name ¥ Questcr % Dain % Lohade % Longhuk v Phoin % Guanity % Mabd % Addional char v Commen
Dt o VInED b Teacker 10 48005 Block-copped chackaden | am corlon | 2/2/2007 |47 7230568 121 S48 1 20
[ ViR Tracker 10 |$505  Spolied inwher | amcorton | TR0 |47 7ETEE 10 %N 1 m

Tracker1 46005}  Dees mouse | om certan | 02572007 477220716 121 965015 1 on

| futvonce| &

4. In the window that opens, select the “Map” icon. It is located on the “New View

Types” tab. A numbered “Map” window will open.

5. Click anywhere on the new map view to make it the active view.

6. Click the “View Properties” icon. The “Map Settings” window will open.

7. Click on the “Image” tab.

8. Click on the ellipsis (...) at the end of the “File” field. Browse to the “Maps”

folder in “My CyberTracker Databases”.

9. Select the file you want to set as the map image, and click “Open”. A small

version of the image will be displayed.

10. Enter the top left and bottom right coordinates in decimal degrees.

a. The coordinates are included in the text file that is included with your

aerial photo — if you purchased an aerial with this software.
b. Make sure you put a “-* in front of longitude.

Some map sources will export these coordinates as “NW” (for “northwest”; same as “top
left”) and “SE” (for “southeast”; same as “bottom right”). For the best map accuracy,

use 6 decimal places.

In North America, latitude increases as you move north, and longitude increases as you
move west. The numbers under “Left Top” are higher than the number under “Bottom

Right”.
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Map Settings

| General || Projection | Image |Layers || Render” Render—Gridl

File |C:'\,Documents and SettingsiPauliy Documents\Naturebdappingyrmapsiduvall BMP

Transparency 100
Longitude -121.99532
Latitude 47.75467
Longitude -121.9493
Latitude 47.71849

T

| ’ Cancel

11. Click on the “General” tab.

12. Click on “Name” and type a new name for the map.

13. Click on “Description” and type a brief description of the map.

14. Click on the “Render” tab.

15. Place a checkmark in the box next to “Show all queries at once”.

Map Settings
General | Projection | Image | Leyers Render  Render- Grid
Fenderer

Show all quenes alonce
Shao BT

Show unused timer points
Unuged timer point colar
Stant Element

Stop Element

Join Element(s)

(@) Foints

() Paths

]

O

B Green

() Grid

X
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16. Click “OK” to close the “Map Settings” window. The map will be added to the
“Map” view.

Troubleshooting
Data show no map but their displayed location is not accurate
e Map edge coordinates are inaccurate
e Make sure if you have data in other parts of the state or country and are included
in ANY of the queries, you may problems finding you map....keep zooming in.
e Inappropriate map projection (Contact map provider)
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Viewing Data on a Map
The active report (which should be Data Viewer) will be displayed on any open maps.

A yellow triangle indicates the location of the selected sighting that matches the record in
the Inspector box. The active sighting can be selected by clicking

e the arrows at the top of the inspector to find the correct record
e on adifferent row on the active table

e 0n a point on the map using the pointer tool.
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How to Delete Sample Data

Multiple sightings can be deleted simultaneously by highlighting more than one row on

the query table. This is done by holding the control key while clicking on each row you
want to delete.

Click the “Delete Sighting” icon.

E NatureTracker - CyberTracker Professional v3.103

File Edit Wew Took Help

= Reports ~ " dgger ~

=} £

X
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= Data viewer ~ » Query Editor ~

@ =] £} = a

MewWiew Deletc Ve ViewProperties  ExportWiew | Manage Reports  Sync

E Query Editor

- Data viewer | Other species | Photo records | Location | “weather | Following -~ Tracker © Tracker 1| Tracker2 | Tracker3  Tracker4 | Tracker5| TrackerB Tracker 7 Tracker8 | TrackerS | Tracker 10 Tracker 11 Tra
=l Properties

~
=1 MoFilter
Mame Data viewer

Date range &l

Advane

Tracker + Obsarve + Species nsme ~ Questior ¥ Date v Lattude v Longtude v Photo v Gusniy v Habit ¥ Addtional obse + Commen
Date from 111580 » Tracker 10 46005 |Black-capped chickades |l am cettain |7/2/2007  47.72305661 121.964403: 1 230
Dateto 14202008 Tracker 10 |4600.5 | Spotied towhee | am certain |7/2/2007 | 477233733 12196471 1 230

[ — Tracker1 |4600.53  |Deer mouse | am certain |8/26/2007 | 47.72287161 -121.965315 1 80
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